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Summary  

Project and Client 

 Gisborne District Council has invested significant effort in the past to capturing farm-

scale Land Use Capability (LUC) mapping for soil conservation planning on hard copy 

maps. 

 This report outlines work done to evaluate the feasibility, costs and benefits of digital 

recovery of these LUC farm and catchment plans. 

Objectives  

 Using one single image farm scale LUC map (1:10 000), and one mosaicked image 

LUC map (multiple properties within a catchment; c. 1:15 840), test methods for 

upgrading these unorthorectified paper maps to orthorectified Geographic Information 

System (GIS) format.  

Methods 

 Original unorthorectified maps were scanned. 

 Contemporary high resolution aerial photography was downloaded from Land 

Information New Zealand (LINZ) Data Service to provide an orthorectified base map 

(assumed to be spatially correct). 

 A high resolution (8 m) digital elevation model was downloaded from LINZ Data 

Service to provide the basis for correction of terrain distortions. 

 Ground control points (GCPs) were identified in both original farm plans and on 

contemporary aerial photography. These represent clearly identifiable features visible 

in both images.  

 The scanned farm plans were orthorectified using a Projective Transform in ERDAS 

Imagine. 

 The orthorectified imagery was reclassified to isolate the original LUC or Land 

Resource Inventory (LRI) line work from the background photographic base.  

 The line work recovered from the image was thinned and converted from raster to 

vector format (vectorized). 

 Vector line work was smoothed and simplified to automatically remove raster artefacts 

and remove any obvious non polygon boundary features (e.g. lettering). 

 Vector line work was manually edited to clean remaining problems. 

 Line work was converted to polygons (topological build) and checked. 

 Polygon attributes were added manually. 

 Time and effort of processing was recorded. 

 The GIS data created was assessed visually for accuracy of fit to underlying 

orthophotography. 
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 Costs and benefits of digital recovery were assessed. 

Results 

 Overall, the orthorectification process appears to have done a good job of aligning 

features in the original map image with the contemporary orthophotography in the farm 

plan example with a single image making up the base map. Comparing obvious 

boundaries such as terrace edges in the 2012 orthophotograph to the processed line 

work suggests offsets of 0–15 m. The result is a good rendition of original inventory 

data ‘as is where is’, and was neither time-consuming nor difficult. 

 The overall orthorectification process for the Waihora catchment mosaic was poorer 

due to the following factors: coarser scale, uncertain image orientation, image 

mosaicking (multiple camera views) and resolution (fidelity), and line work being held 

on a separate map. Comparing obvious boundaries such as terrace edges in the 2012 

orthophotograph to the processed line work suggests offsets of 25–50 m. The result is a 

less satisfactory rendition of original inventory data, despite requiring more GCPs and 

more time to process.   

Conclusions 

 The degree to which paired GCP identification can be successfully carried out is the 

critical success factor in achieving an acceptable outcome. 

 Using projective transformation with an underlying digital elevation model (DEM) to 

orthorectify photo maps of LRI/LUC farm plans is an effective approach for single 

images at larger scale (1:10 000 scale or better), but not for mosaics at 1:15 000 scale or 

smaller as issues of multiple camera views, scale and image quality prevent an 

acceptable standard of orthorectification from the original scanned map. 

 Recompilation of a new map based on contemporary (2012) orthophotographs and/or 

refinement of orthorectified boundaries according to the same contemporary 

orthophotographs was not attempted. While this seems an attractive possibility, the 

difficulty of correcting boundaries that incorporate hard-to-observe factors such as 

lithology without field checking render an office-only approach inadvisable.  

 A preliminary cost-benefit analysis of the perceived value of the LUC data versus the 

cost of data recovery suggests that data recovery into GIS is worthwhile, with costs 

being recovered within 1.4–4.5 years. 

Recommendations 

 ALL photomaps should be scanned to an acceptable quality for digital archiving. At an 

estimated cost of $15 to $20 per sheet, the total cost of scanning the full archive of 

physical maps should not exceed $10,000.  

 Gisborne District Council should cost options for recovery of farm plans on single 

unorthorectified photo maps into GIS format using the projective transformation 

approach outlined in this report. 

 Catchment plans should only be orthorectified in high priority cases or where the 

quality of the photomaps is good enough to give an acceptable result. 
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1 Introduction  

Land Use Capability (LUC) at a property scale gives an inventory of the land’s resources and 

capability, from which recommendations on land use and appropriate soil conservation 

measures can be determined. This is valuable information that can be used in advocacy 

activities to encourage changes to present land use practices. It is also fundamental for policy 

development and setting resource consent conditions pertaining to vegetation clearance or 

earthworks.  

The Gisborne District Council (GDC) has carried out LUC mapping at a scale necessary for 

land management decisions over approximately half of their district (270,000 ha). Both the 

detailed inventory data used to compile the LUC maps, and the LUC maps themselves are 

held on hard copy unorthorectified aerial photo maps. Although now 35 years old, these data 

represent a significant investment and continue to be an essential component of land 

management planning.  

In their current form they are unusable in a Geographic Information System (GIS) as the line 

work contains terrain induced distortions, preventing alignment with modern data sets such as 

Land Cover Database (LCDB 2014), S-Map (Lilburne et al. 2012), digital terrain data and 

contemporary aerial photography. They are also at risk of damage or loss. To be fully utilised 

and preserved, they need to be accurately portrayed in terms of the New Zealand Transverse 

Mercator (NZTM) grid, and readily available in a GIS to council staff, researchers, land 

owners, land developers and the general public.  

GDC has manually transformed selected LUC units that remain without effective tree cover 

into an Overlay 3A GIS layer in its District Plan. Overlay 3A identifies severely erosion-

prone land within Gisborne District that requires establishment and maintenance of suitable 

tree cover, including land suitable only for indigenous revegetation, and not for productive 

use. The manual transformation of LUC units into Overlay 3A involved considerable cost and 

was done to support an important suite of Resource Management Act (RMA) rules. 

Additional LUC mapping would support non-rule based methods on surrounding land but 

large-scale remapping of farm plans would be an insupportable expense, so this project seeks 

options to leverage the value of the previous mapping effort at minimal cost 

The standard method for digitizing vector line work (e.g. an LUC, LRI or soil map) into a 

GIS has been to compile the line work onto a geometrically correct topographic base map 

that includes georeferencing information for a recognised coordinate system such as the New 

Zealand Map Grid (NZMG) or the NZTM projection. Then, either through the use of a 

digitizing platen or, more recently, heads-up-digitizing techniques on a scanned image of the 

original map drawing, the vector line work can be captured and transferred into a GIS 

database for later map production, analysis and re-use. This ensures that the original vector 

line work, within the limits of scale, accuracy and precision of the base map and the map 

compilation process, is relatively free of terrain distortion and other source data errors.   

However, because GDC’s hard copy LUC farm plans were compiled onto non-orthorectified 

aerial photography, and because they cover areas of moderately steep hill country terrain, 

they include significant terrain distortions. In addition these maps have no georeferencing 

information or fiducial marks recorded on the maps. This project’s goal is to establish 

whether such hard copy maps can be digitized to an acceptable standard. 
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2 Objectives 

Test up to four methods for upgrading unorthorectified maps, using one single image farm 

scale LUC map (1:10 000), and a mosaicked image LUC map (multiple properties within a 

catchment, approx. 1:15 840): 

1. Rubber sheeting: georeferencing using common ground control points (GCPs) 

identifiable on the legacy maps and on contemporary orthorectified imagery to force 

the unorthorectified imagery to conform to the orthorectified imagery. 

2. Orthorectification: using a reduced set of GCPs to option 1, a digital elevation model 

(DEM), and estimated camera/lens parameters, attempt full orthorectification 

processing to remove terrain distortion from the legacy LUC maps. 

3. Manual recompilation: for the single image farm scale LUC map manually recompile 

line work directly onto contemporary orthorectified imagery. (Manually recompiling 

the catchment map was too great a task to attempt within the framework of this grant.) 

4. Automated mapping: using slope and terrain analysis from the best available digital 

elevation model (DEM), develop an automated set of boundaries to compare with 

those from the other methods.   

Prepare a brief report evaluating the results from these four options, with particular reference 

to the accuracy and precision of the re-processed maps, and the cost/benefit for this work.  

Supply the examples of reprocessed maps/datasets, and present recommendations for 

upgrading the existing archive of farm plans and catchment plans.  
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3 Methods 

3.1 Preparing and collating basic data resources for all methods 

Hard copy LRI and LUC maps were supplied by GDC in the form of panchromatic aerial 

photographs with hand-drawn line work and text, or hand-traced polygon maps with 

associated text. All maps had been reproduced on stable base, and represented an example of 

a farm-scale map (Belmont Station) and a medium sized catchment-scale map (Waihora 

Catchment).  

The Belmont Station maps were compiled in 1983 on New Zealand Aerial Mapping Survey 

#5758, photo D/4, quoted at 1:10 000 scale and flown on 29
th

 September 1980  

The Waihora Catchment map uses a New Zealand Aerial Mapping photo mosaic, according 

to metadata on the map face, built from Surveys 3195-3560, negative number E877, quoted 

as 1:15 840 scale and compiled in January 1979.  

The hard copy maps supplied had the following physical dimensions: 

Waihora Catchment  960 mm x 700 mm (c.f. A0 = 1189 mm x 841mm) 

Belmont Farm  550 mm x 410 mm (c.f. A2 = 594 mm x 420 mm) 

These photo maps were scanned at a standard commercial print and copy business 

(http://www.cq.co.nz ) as full colour 600 dpi resolution TIFF files (Figures 1a and 1b). 

Although more expensive, the colour scanning was specified to take advantage of any sepia 

toning and/or fading, to assist with isolating the black line work and text from the background 

during image processing. Scanning costs were c. $15 per sheet. The Waihora catchment land 

inventory line drawing was scanned in black and white. 

The Waihora map line drawing was subjected to a simple image reclassification to render a 

binary layer, which was displayed over the LUC photo map of the same area. The previously 

black lines and text from the line drawing were displayed in red, and the white background 

was made transparent, to expose the underlying photo base map and LUC text and line work 

(Figure 2). Using the ArcGIS
©

 (ESRI, 2015) simple georeferencing tools, I used “line work 

GCPs” to align the common line work in the two images, and exported the combined image 

to a TIFF file for processing through the more sophisticated rectification tools of ERDAS 

IMAGINE
©

 (Hexagon, 2015). I also aligned the final images to True North, since the original 

drawing was misaligned by about 70°.  

I used contemporary orthorectified aerial photographs from the LINZ data service 

(https://data.linz.govt.nz/layer/1722-gisborne-04m-rural-aerial-photos-2012-2013/ ) to 

identify correct orthorectified GCPs. This orthophotography was taken by NZ Aerial 

Mapping Ltd during 2012 and 2013, encompasses the entire GDC area, and is supplied in 

terms of NZTM map projection with 40 cm pixel resolution (0.4m GSD), in 3-band (RGB) 

uncompressed GeoTIFF format. The final spatial accuracy is +/-2.0 m (at 90% confidence). 

In the absence of field-collected Global Positioning System (GPS) data I assumed coordinates 

derived from this data were substantially correct. 
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Figure 1a Belmont Station scanned image/map – note the sepia toning of the image and line work and text and 

ancillary map information recorded directly onto the photographic base. 

 

Figure 1b Close-up of line work and LUC coding for Belmont Station photo map. 

[
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Figure 2 Close-up of part of the Waihora catchment transformed base map. The line work from the inventory 

and the photo map of LUC have been combined with the text and lines of the inventory separated from the 

background image, before orthorectification.  

 

In the absence of local LiDAR data (Renslow 2013) at a resolution consistent with the 

contemporary orthorectified aerial photography, I considered using three DEMs for 

orthorectifcation. These were the Landcare Research (LCR) national 25m DEM 

(https://lris.scinfo.org.nz/layer/131-nzdem-north-island-25-metre/ ), the LCR 15-m resolution 

EcoSat DEM (http://www.landcareresearch.co.nz/resources/maps-

satellites/ecosat/about/specifications) and the Geographx 8m DEM national coverage 

(https://data.linz.govt.nz/layer/1768-nz-8m-digital-elevation-model-2012/ ). All three DEMs 

are derived from the same LINZ Topo50 20m contour and related topographic datasets (spot 

heights, lake shorelines and coastline;  https://data.linz.govt.nz/data/category/topographic/nz-

topo-50-data/ ) but by different interpolation methods.  Spatial accuracy is nominally the 

same as for the LINZ source data: 90% of well-defined points are ±22 m horizontally and 

±10 m vertically. 

3.2 Rectification using rubber sheeting 

The Georeferencing tool in ArcGIS 10.2 allows the user to georeference an image 

approximately. This follows the standard procedure for identifying GCPs in the raw image 

pixel coordinates and in a projected coordinate system. ArcGIS offers zero order (simple x, y 

shift), 1st order (affine - linear), and 2nd and 3rd order polynomial transformations, as well as 

‘Adjust’, ‘Spline’ and ‘Projective’ transformations. 

In ArcGIS none of these transformations explicitly handles terrain distortion, but each 

progressively offers more complex capability for using multiple GCPs to manage image 

[
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distortion. Choosing the polynomial transformations solves the problem of attempting a 

mathematical best fit across the whole image; GCPs will not exactly match locations 

everywhere but errors will be minimized. (The adjust, spline and projective transforms offer 

local polynomial transformations that will resolve local distortions and should ensure a better 

fit at the GCP locations, but cannot guarantee good fit away from the GCPs.) In low relief 

areas this approach can yield acceptable results. In higher relief areas use of a large number 

of carefully placed GCPs can yield useable results, but the transformations cannot resolve 

terrain effects without a great deal of GCP data. 

3.3 Projective transformation (orthorectification) 

Orthorecification of aerial photography or satellite imagery normally requires at least a 

camera model based on camera specifications (e.g., focal length) and information about the 

altitude and orientation of the sensor. This information can be used to reduce perspective 

distortion. In the case of historical aerial photographs, this information is usually lacking, so a 

true orthorectification is not possible. However, the ERDAS IMAGINE Projective Transform 

model provides a simulation model purely solved by GCPs, but with the important difference 

from the ArcGIS Projective Transformation being that IMAGINE includes the ability to 

assign a z coordinate (elevation) to GCPs, and then uses a DEM to account for terrain 

distortion.  

In all cases GCPs must accurately locate features visible on the original scanned images with 

the actual ground targets (including the elevation of the ground target). This can be achieved 

through GPS survey field work, but this is expensive and time consuming.  Where good 

quality contemporary orthorectified imagery is available, orthorectification is possible using 

paired GCPs identified respectively in the original scanned imagery and in the contemporary 

orthorectified imagery. This equates to capturing a pair of points marking the GCP location in 

both raw image Cartesian coordinates (x, y pixels from the 0,0 image origin) and in properly 

projected and georeferenced coordinates, the latter with an additional elevation (z coordinate) 

derived from the DEM. 

Step by step processing instructions can be found in Appendix 1. Key elements are 

summarised here: 

1. Prepare data (scan historical and contemporary imagery and acquire a suitable DEM). 

2. Open Multipoint Geometric Correction dialogue (see Figure 3). 

3. Collect and save GCPs. 

4. Solve and save model. 

5. Calibrate image. 

6. Run transformation model. 
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Figure 3 The selection of GCPs. Features identifiable in both the original 1983 photo map (left) and in the contemporary 2012 orthophotography (right). The table at the 

bottom of the screen shows image pixel coordinates, NZTM coordinates, and elevations for the GCPs, along with RMS error estimates for the model solution.
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The end result of the projective transformation is an orthorectified version of the original 

scanned image (e.g., Figure 4). This image is then subjected to a supervised classification 

process to isolate the line work from the background image (Figure 5). The resulting image is 

transferred to ArcGIS 10.2 (ESRI, 2014) for further post-processing conversion into vector 

line work including: 

1. Thinning raster representation of lines to single pixel width (Figure 6). 

2. Raster to feature conversion to create vector line work (Figure 7). 

3. Smooth and simplify line work to remove raster artefacts (Figure 8). 

4. Select and remove obvious non polygon boundary features (e.g., lettering). 

5. Manual editing to clean remaining line work (Figure 9). 

6. Build polygon topology. 

7. Manual editing of polygon attributes (Figure 10). 

3.4 Manual Recompilation 

There were insufficient resources in this project for a manual recompilation of the original 

map or a new mapping exercise to derive a land resource map to contemporary standards. 

However, a visual comparison of the original line work and the DEM-based slope assessment 

(see next section) was used to give an indication of how well the transformed original lines 

relate to the landscape as currently visible in the contemporary orthophotography. 

3.5 Automated mapping from DEM 

An approach to deriving initial polygon boundaries that has shown promise elsewhere was 

applied to Belmont Station (Basher  et al. 2014). This is a terrain segmentation analysis in 

which slope information derived using the contour-based 8-m DEM was classified and 

mapped in broadly homogeneous regions of similar slope using an automated modeling 

procedure in ArcGIS 10.2 (Figure 11). The model uses the DEM to make a slope map and 

reclassifies slope into NZLRI classes A to G to make a classified slope grid. The focal 

statistics function is used to give each cell the majority slope class for a circle of radius 3 

cells (c. 24 m at 8-m resolution). This acts as a filter to simplify the slope map to filter out 

individual cells that have slope class different from all of their neighbours. This filtered slope 

map is then converted using the Raster to Polygon tool to a vector format, and processing is 

done to merge small polygons (<1000 m
2
) with larger neighbours using the eliminate 

function. Next a smoothing function is used to convert the slope class polygon boundaries 

that precisely follow raster cell edges to smooth boundaries, and then a dissolve function is 

used to delete unnecessary boundaries, merging neighbouring polygons with the same slope 

class. Because the smoothing function creates many vertices in polygon boundaries a 

simplify function is used to reduce these vertices without over-simplifying the polygon’s 

shape. A final eliminate function is used to merge areas <2500 m
2
 (0.25 ha) with their larger 



Land Use Capability Information Recovery: A Gisborne Example 

Landcare Research  Page 9 

neighbours and finally, zonal statistics provides the mean, maximum and minimum slope 

from the original slope grid for the newly created polygons. 

The results of this slope analysis are compared with the manual 1983 LRI mapping.  

 

 

Figure 4 The Belmont Station photo map after projective transformation. The effect of the terrain correction is 

apparent in the uneven, non-parallel edges of the photo map and the localised distortion of some of the text. 

[
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Figure 5 Using raster reclass on the transformed Waihora catchment photo map shown in Figure 5, the red lines 

and text have been isolated from the background image for vector processing.  

 

 

Figure 6 Lines from the raster image in Figure 6 are thinned to one pixel to convert to vector line work.  

 

[

[
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Figure 7 The result of vectorizing the one-pixel wide lines of the raster image in Figure 7. All of the text, hooks 

and arrows have been vectorized also and need to be removed to complete vectorization of line work, in order to 

generate topologically correct polygons. 

 

 

Figure 8 Based on line length and sinuosity, a significant fraction of the text and spurious lines from Figure 8 

have been removed. There is an unwanted consequence that some ‘genuine’ short line segments may also have 

been deleted. Remaining editing must be manual.  

[

[
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Figure 9 Final clean polygon boundaries, with all text and extraneous line work in Figure 9 removed and 

polygon topology checked against the original photo map boundaries and LRI/LUC coding. 

 

 

Figure 10 Part of the final topologically correct GIS database for the Waihora catchment, with polygons 

labelled according to LUC classification.

[

[
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Figure 11 The DEM slope segmentation analysis was implemented in ArcGIS 10.2 model builder, which creates a smoothed raster slope map (A), and converts to detailed 

slope polygons (B). It then dissolves unnecessary boundaries, smoothes and simplifies remaining boundaries (C), before segmenting the area into relatively homogeneous 

slope units using select and eliminate commands to identify and merge very small slope units (D). Finally slope statistics from the original raster slope map are assigned to 

each slope unit (E). Settings can be modified to tune the delineation of homogeneous slope class parcels, depending on the mapping scale required. 

 

A 

B 

C 

D 

E 
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3.6 Image classification and final editing 

No fully automated process of converting raster line work into vector line work can deliver a 

useable final product, particularly where the original hard copy was not prepared with this 

specific purpose in mind (e.g. cleanly traced line work only with careful attention to 

topological correctness). Photomaps like the ones used here abound with ‘extraneous’ 

information. This is what makes it possible to attempt orthorectification, but it is also a major 

impediment to vectorization. Automated GIS universal editing procedures exist for all the 

necessary steps, but there are always compromises between degrees of automation and 

accuracy when using them. Over-simplification of the dataset through using universal editing 

functions almost always leads to unusable data, but some automation is required to avoid 

making large numbers of manual corrections, which are time-consuming and therefore 

expensive.  For a useable GIS vector dataset, some manual editing will always be required to 

clean up the results of automated processing. In this pilot study manual editing was carried 

out using ArcGIS 10.2, including deleting text, joining up hashed lines, and entering polygon 

attribute data, which is recorded on the scanned map as an image (i.e. not machine readable 

ASCII text).  

3.6.1 Removing the bulk of the lettering semi-automatically.  

Within the vector line model, each line segment defining a polygon boundary or text feature 

from the map image has a length. Nearly all of the long polygon boundaries are longer than 

the letters. In addition letters tend to have more complex shapes relative to their length. I used 

a sinuosity script to calculate the ratio of total line length to shortest distance between the two 

ends of the line 

(http://www.arcgis.com/home/item.html?id=00e708a448b74810a0e805c4a97f9d46 -

downloaded 15-1-2015). 

3.6.2 Dealing with hashed lines.  

The hashed lines between areas of similar LUC classification but different land inventory are 

a problem with the data provided by GDC. The GIS needs all lines to be continuous and to 

fully enclose the space to which they refer. Because the vectorization process often leads to 

kinks in line ends (e.g. Figure 9), extending lines in the hope they will intersect was 

ineffective, and so this process was carried out largely manually. Approximate time taken for 

editing both the Belmont Farm and Waihora Catchment line work was recorded to assess the 

viability of this step at the two scales. 

3.6.3 Entering polygon attribute data.  

There are two options for entering polygon attribute data, either fully manually or through the 

use of optical character recognition (OCR). OCR works best with typeface rather than 

handwritten text because the characters are more consistently formed.  After some initial 

tests, and because the LRI/LUC codes are not plain language words, I decided to use manual 

editing. This involved adding the necessary fields to the GIS vector polygon database (e.g. 

rock, slope, erosion, vegetation and LUC), turning on the orthorectified image of the original 

map in the background with the text to be entered written on it, and then selecting each 

polygon in turn and typing in the text relevant to that polygon. 
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4 Results 

4.1 Specific issues and outcomes 

4.1.1 Identification of GCPs.  

The accuracy of the orthorectification process is reliant on the quality of ground control that 

can be achieved. The following image pairs illustrate the range of GCP identification 

challenges encountered during this project. 

Figure 12 gives a clear illustration of good GCP identification. Not only does the distinctive 

triangular spur come to a sharp and easily identified apex on both images, but a number of the 

individual trees (and groupings of trees) are sufficiently well preserved between 1983 and 

2012-13 that GCPs centred on specific tree canopies give moderately accurate GCPs that are 

certainly within the precision of the mapping being georeferenced. 

 

Figure 12 A distinctive spur (A) and individual trees (B) on the Belmont Station imagery: contemporary 

orthophotography (left) and original panchromatic aerial photograph (right).  

 

Man-made objects are often the best GCPs since they often have sharp corners (buildings and 

sometimes fields/fences) or they have distinctive shapes and intersections (roads). Rivers 

(meanders and intersections) can also be useful but they can be subject to subtle change 

through time that can be confusing. Figure 13 illustrates a group of buildings in the Belmont 

Station imagery. The house (upper centre) has been added to and there are a range of 

buildings nearer the river that are not present in the 1983 imagery. However, the farm 

building in the centre of the upper left quadrant of both images appears to retain the same 

footprint in 1983 and 2013, and is sufficiently well defined to use a corner of the roof as a 

GCP, which should deliver the highest level of GCP precision and accuracy. Figure 14 

illustrates a similar scene in the Waihora catchment imagery, showing a curving road running 

through a patch of bush to some farm buildings. However, the road intersection at the start of 

the curving road is obscured by the catchment boundary line and, because of vegetation and 

building changes, the best GCP in this area may be the inverted Y-intersection on the road 

B 
B 

A A 

[
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between the patch of bush in the middle of the image and the garden area surrounding the 

farm buildings to its left (east). While there are buildings and some trees in this image, it is 

harder to identify specific objects than in Figure 13, due to the smaller-scale imagery and 

quality reduction after multiple reproductions. Figure 15 (also on the Waihora catchment 

map) shows a range of farm buildings where it is both difficult to match buildings or other 

natural features like trees between the original and contemporary images.  

 

Figure 13 Belmont Station imagery showing buildings, roads and yards in the contemporary orthophotography 

(left) and original panchromatic aerial photograph (right). 

 

 

Figure 14 Waihora catchment imagery showing buildings and roads in the contemporary (left) and original 

orthophotography (right). Note the original imagery is a composite of panchromatic aerial photograph and black 

LUC line work and text, overlaid with red land resource inventory line work and text. 

[

[
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Figure 15 Waihora catchment imagery showing buildings and roads in the contemporary (left) and original 

orthophotography (right). Compared with figure 13, buildings and features are much more difficult to identify 

and use as GCPs. 

4.1.2 Changes between image dates (vegetation) 

Identifying GCPs in area with forestry or scrub reversion was very challenging since many of 

the identifiable features in the landscape are obscured. Figure 16 illustrates a case in the 

Waihora catchment with changes in land cover to plantation forestry and no obvious man-

made features for ground control. The fence line shown in the 1979 image appears to mark 

the forest boundary in the 2013 orthophotograph. The stream intersections in the 2013 image 

are hard to identify precisely on the older image, so there are few options for good quality 

GCPs in this part of the photo map.  

 

 

Figure 16 Waihora catchment imagery showing changes in land cover between the contemporary (left) and 

original orthophotograph (right) and the challenges of identifying GCPs using natural features. 

[

[
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4.1.3 Changes between images (erosion) 

There are some obvious changes between imagery in terms of visible erosion features.  For 

example, Figure 17shows the main section of a large earthflow which is clearly visible in 

both images.  However, it appears to have expanded significantly since 1979 although the 

diagonal line of bare ground just below the centre of the image is clearly visible in both 

images, as are three of the four ponds in the 2012 imagery. The pond at lower centre of the 

image is partly obscured by line work in the 1979 imagery, the pond just above the centre of 

the image has changed shape quite markedly by 2012, and the pond at extreme upper right in 

the 2012 imagery does not appear to be present in the 1979 imagery. GCP identification in an 

area of change and movement of visible features should be avoided. 

Where erosion is recorded, the 1979 images are much harder to interpret than the 2012 

images. This is particularly so for the Waihora Catchment maps. Figure 18 provides an 

example where the 1979 aerial photography lacks the definition needed to clearly identify 

erosion features, and the 2012 orthophotography shows significant scrub and erosion control 

planting that effectively masks evidence of erosion features that might have been present 

during the 1983 field survey. 

 

 

Figure 17 The earthflow in this area appears to have expanded, particularly northward, and despite obvious 

erosion control planting, there appears to be significantly more bare ground in 2012 (left) than in 1979 (right). 

Recorded as 2eF1G in the farm plan, based on an area of approximately 9 hectares, this unit might now be 

recorded as 4eF. 

 

[
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Figure 18 Contemporary (left) and original orthophotograph (right) of a polygon scored as severely eroded in 

1983 (4S12eF1Su). Erosion is not obvious in this polygon in 1979 (B), because the photograph is not clear 

enough to assess, nor is erosion apparent in the same area in 2012 (A), when the area has been afforested or has 

experienced scrub reversion, to the point that evidence of erosion is masked. 

4.1.4 Dashed lines 

A major issue for polygon capture is that GDC mapping protocols for LRI maps appear to be 

that boundaries between areas of similar LUC but different inventory are separated by dashed 

lines. When using the method described the result is broken vector line work that does not 

enclose the area in question. Manual editing is the most reliable way to correct this line work 

to get a topologically correct result. Automated techniques appear to cause more problems 

than they solve. Figures 8, 9, 14 and 16 all include examples of these dashed lines. 

4.1.5 Fence lines 

An additional problem with GDC mapping protocols is that fence lines are also shown on 

maps as thinner black lines with a double crossing bar to differentiate them from LUC 

boundaries. This confounds vectorization since automated procedures fail to differentiate 

these lines from LUC boundaries, and they have to be removed manually. Fence lines are 

visible in Figures 5, 14, 15, 16, 17 and 18. 

4.1.6 Text and Arrows 

Finally, the following are also confounding factors for vectorization: all of the inventory and 

LUC text, arrows connecting text to small polygons, and hooks connecting small polygons 

with no inventory or LUC to larger polygons that do have coding (see Figures 5, 6, 7 and 8). 

After processing the images to vector line work I tried to remove obvious text and hooks 

according to their length and sinuosity (compare Figures 8 and 9). Letters tend to have lines 

with more curvature relative to their short length than polygon boundaries. Line segments 

with length less than 50 m and sinuosity index greater than 0.8 were deleted, which removed 

around 75% of text line work but also removed some very short sections of complex polygon 

A 
B 

[
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boundary that needed to be reinstated manually. Nonetheless, I was able to reduce the amount 

of manual deletion and editing required to clean the line work using this process. 

4.1.7 Mosaic versus single image 

The Waihora catchment map is based on an image mosaic, created by manually tearing or 

cutting a set of photo prints and gluing the images together to form a mosaic, which would 

then have been photographically reproduced to create the base map. This would normally use 

the centre of each photograph where distortions are least because the camera has the nearest 

to a vertical view. The use of ‘rough edged’ tiles in the mosaic is to reduce the appearance of 

tile edges; however, these may be observable on close inspection. Because this is a mosaic of 

unorthorectified images, there are still distortions in the image tiles so some features may 

appear twice or not appear at all at the edge of image tiles. Figure 19 shows one of these tile 

edges and the duplication of what is probably scrubby vegetation in a gully. 

Identifying GCPs in this part of the images is extremely difficult. There are no features 

clearly identifiable in both images and the probable double-up in the 1979 image exacerbates 

the situation. The line work over the 1979 image makes it difficult to match the stream line 

meanders, which may have also changed over the 35 years. Even if a GCP could be 

identified, the projective transform process cannot work with the multiple camera views of 

the mosaic, and will also be confounded by the intense local distortions caused by the mosaic 

edges.  The only options would be to identify image edges and separate out the mosaic to do 

projective transforms on the single image tiles, or to use rubber sheeting with extremely large 

numbers of GCPs.    

 

 

Figure 19 Waihora catchment map for 2013 (left) and 1979 (right). The 1979 image shows the tile edge in the 

mosaic as a diagonal blurred line, and what appears to be an area of scrub in a gully that is repeated in the 

image.  Matching the 2013 image to the 1979 original is thus more difficult than in previous figures.  

[
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4.1.8 Map Scale 

Not only are the mosaicked catchment maps at a smaller scale than the farm plan, so that 

pixel sizes are effectively more than twice as large making small objects hard to identify, but 

the manual mosaicking process required that a photographic reproduction of the physical 

mosaic be made, and this has then been reproduced onto the stable base. Each time the 

original image negatives are printed or reproduced, there is potential for loss of information 

in the image. The net effect of this can be observed by comparing the right hand photograph  

in Figure13 with its corresponding catchment scale photomap in Figure 14, which has poor 

image resolution, making it difficult to identify targets. 

4.1.9 DEM resolution and outcome 

The 8m DEM used in this project has been generated by interpolating elevation on a regular 

grid between 20m contours and spot height data, which results in a smoothed representation 

of the real terrain surface. By comparison, the resolution of the 1979 aerial photography is 

approximately 2–5 m and the resolution of the 2012 orthophotography is 0.4 m.  Using a 

coarser resolution DEM to account for terrain distortion is common practice (Congalton and 

Green 2008). In assessing the accuracy of the final LUC maps generated through the 

procedures outlined here, it is important to appreciate that the orthorectification process will 

not have data to deal with very fine-scale terrain distortions, which must occur in the raw 

aerial photographs. These may include distortions caused by sharp terrain edges (e.g. ridge 

lines, terrace edges) or changes in canopy height (e.g. abrupt forest to pasture boundaries). 

Poor alignment of line work from the older aerial photographs against the very high 

resolution 2012 orthophotographs may be attributed as much to DEM resolution as to error in 

GCP location. Use of a LiDAR-based DEM with a resolution of 1m or less would most 

probably resolve many of these concerns. 

4.1.10 Note on mapping standards of line work 

This project has transferred the line work from the Belmont and Waihora photo maps ‘as is, 

where is’ into an orthorectified form in terms of the NZTM projection. While the line work 

appears to fit the landscape depicted in the 2012 orthophotograph acceptably well, the quality 

of that original line work has not been assessed.  

4.1.11 Errors in source maps 

A number of mapping errors emerged when capturing the data from the paper maps.  

Topological errors (missing boundaries etc.) may occur on the hard copy maps and have not 

been detected until trying to reconcile line work and coding in the GIS editing process. Most 

commonly, transferring the attribute data to the GIS may pick up some errors in recognising 

where polygons have not been properly closed to each other, resulting in multiple inventory 

information for a single defined area. There were examples of this in the Waihora map 

particularly, although these are less likely to be found on the smaller, simpler farm plans like 

the Belmont Station map.  
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Attribute errors also occur, generally as incomplete codes or missing attributes, hooks to 

nowhere, or hooked polygons that appear to have no coding. Because the LUC and LRI 

coding are stored on separate maps, and the LUC maps ignore dashed lines from the LRI 

maps, there are occurrences of missing or apparently conflicting LUC codes. In the latter 

case, this means polygons separated by a dashed line in the LRI map (implying LUC should 

be the same) have different codes in the LUC map. 

Overall the error rate appears to be low, and is not atypical of manually drawn maps without 

the additional quality assurance checks of the GIS in building topology.   

4.2 Overall results 

4.2.1 Belmont 

Figure 20 illustrates the final result of orthorectification and vectorization of the Belmont 

Station LRI/LUC map. Overall, the orthorectification process appears to have done a good 

job of aligning features in the original image with the contemporary orthophotography. 

Comparing obvious boundaries such as terrace edges in the 2012 orthophotograph to the 

processed line work suggests offsets of 0–15 m. The result is a good rendition of original 

inventory data ‘as is where is’ that was neither time-consuming nor difficult to achieve. 

Figure 21 gives a closer view of some of these boundaries, confirming that within the limits 

of 1983 aerial photographic scale, intended LUC mapping scale, mapping standards of the 

day, and possible temporal changes in features like stream banks, the agreement between the 

polygon boundaries drawn in 1983 and the 2012 orthophotography is very good.  
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Figure 20 Belmont Station showing the land inventory polygons with LUC classifications as labels. The overall 

fit of the original mapping to both the LINZ property boundary and to the landscape are good. 

 

Use of contemporary imagery and/or field work would undoubtedly yield different and more 

detailed line work than the original assessment for at least some parts of the property. 

Because it was not possible to carry out field checks within the scope of this project, no 

attempt to manually recompile the LUC maps onto the 2012 orthophotography base was 

made. For example, whether the rock type has been correctly delineated at the farm scale 

cannot be assessed without field work, and the present erosion may be significantly different 

from that recorded in 1983, given the 1988 Cyclone Bola. Field work would effectively mean 

remapping the property, which has already been identified as not feasible within current 

resource constraints. 

[
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Figure 21 Close up view of Belmont Station polygon boundary fit to landscape depicted in the contemporary 

orthophotograph.  The fit is not perfect, but allowing for map scales and drafting standards in 1983, the final 

product shows very good alignment. 

 

 

Figure 22 Slope class map from the orthorectified original LRI/LUC survey (A) and the DEM-based slope 

analysis of the 8m DEM derived from LINZ 20m contours (B). 

  

[

[
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4.2.2 Waihora 

The Waihora Catchment LUC map presented at least six additional challenges.  

a) Scale: the Waihora map is at a smaller scale (1:15 000) than the Belmont Station map 

(1:10 000), so 1 cm
2
 of the Waihora map represents 2.5 times the area on the Belmont 

map. As the effective pixel size is 2.5 times greater in the Waihora photos, seeing 

specific detail is more difficult. 

b) Inventory not on a photo base: this necessitated pre-processing to combine the raw 

scanned inventory and LUC maps, which must introduce some error in alignment of 

boundaries, as well as increasing the amount of line work on the map (see f below). 

However, it did have the advantage of separating out more readily the dashed lines in 

the inventory map that delineated inventory polygons with different inventory codes 

but deemed to have the same LUC classification. 

c) Orientation: the original photo mosaic map had an incorrectly orientated north arrow, 

necessitating a ‘rough’ re-orientation to facilitate GCP identification. Trying to find 

and match suitable GCPs is difficult when working with paired images that are in 

different orientations relative to each other.  

d) Mosaic: the method of mosaicking relies on using the centres of overlapping images 

(nearest to vertical view) to give the least terrain distortion. The amount of distortion 

varies unpredictably and in places discontinuously across edges of the original images 

in the mosaic. 

e) Fidelity: because the Waihora mosaic has been manually created and then reproduced 

to form the photo base in the map, there has been some loss of fidelity in the image. 

This is perhaps best exemplified in Figures 13 and 14; identifying buildings is much 

easier in the higher resolution Belmont photo than in the Waihora photo. 

f) Line work: in combination with all of the above, the line work of the land inventory 

obscures more of the 1:15 000 scale photo maps.  

The net result of these six factors is that the location and accuracy of GCPs is poorer in the 

Waihora map, and in some cases GCPs will be misplaced relative to each other across the 

joins between original images in the mosaic. In turn, the result of poorer quality GCPs is that 

the orthorectification achieved through the projective transform is poorer and more variable 

than for the Belmont Station example (Figure 23). 

The time required to process a larger dataset is greater and may not be simply correlated to 

increasing area. For example, approximately 40 GCPs were used on both photo maps for 

orthorectification. To achieve the same GCP to area ratio in the Waihora map would have 

required over 1300 GCPs, with no guarantee of a similar quality result. Table 1 summarizes 

some key statistics of the spatial scale of these two datasets, which helps explain why it is 

more difficult to achieve a good quality result for the more complex area.  
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Figure 23 Part of the completed GIS data set for the Waihora catchment. The polygon line work is broadly 

correlated to the landscape, but exhibits locational mismatches of 25–50m, and the match between polygons as 

drawn and the underlying terrain is less clear than for the farm plan scale image. 

 

Table 1  Key statistics in terms of the spatial scale of these two datasets.  

 Belmont Station Waihora Catchment 

Total Area 312 ha 10 600 ha 

Number GCPs 40 40 

Hectares/GCP 7.8 265 

Number Polygons 91 1231 

Minimum Polygon size 0.18 ha 0.19 ha 

Mean Polygon size 3.4 ha 8.6 ha 

Maximum Polygon size 11.8 ha 209 ha 

 

An automated slope mapping analysis was also carried out for the Waihora catchment data 

set. As with the Belmont Station slope analysis, this was limited by the fact that all of the 

available DEMs were based on the same 20m contour data, which are being pushed beyond 

their intended scale range. Figure 24 illustrates the comparison between slope mapping in the 

original survey and from the DEM. As with Belmont Station, the DEM-based analysis 

suggests that more refined boundaries could be achieved even with this DEM.  

 

[
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Figure 24 Part of the completed GIS data set for the Waihora catchment. The left hand image has black lines 

and labelling showing the segmentation analysis of slope to divide the DEM up into broadly homogeneous slope 

units, overlaid on the 8m DEM slope map from which they were derived. The right hand image shows the 1979 

inventory map for the same area, shaded on dominant slope but with labels showing the full inventory slope 

code. 

 

Due to the mix of different data sources, terrain distortion and human slope interpretation, the 

match between the DEM-based slope units and the LUC map units are difficult to interpret. 

The LUC mapping seems to overestimate mid-range slopes, with significant areas in the 

centre of the image being mapped at least one slope class steeper than the DEM analysis, and 

markedly less area of lower slope (class C) than from the DEM analysis. By contrast, steeper 

slopes (classes F and G) seem to underestimated along the southern and western edges of the 

area. 

If the DEM-based analysis was used to derive slope polygons as an initial step in LUC 

mapping, the resulting polygon boundaries and LUC map could look significantly different 

from the manually compiled 1979 map. 

4.2.3 Estimated time and costs associated with each step 

Estimated time and costs associated with each step is as follows:  

Table 2 Belmont Station (91 polygons) 

 Task Time (hours) 

1 GCP identification 1 

2 Orthorectification processing and checking 1 

3 Line work cleaning and editing – topological build 1 

4 Adding LRI/LUC attributes 1 

 Total 4 

 

[



Land Use Capability Information Recovery: A Gisborne Example 

Page 28  Landcare Research 

Table 3 Waihora catchment (1200+ polygons) 

 Task Time (hours) 

1 GCP identification 2 

2 Orthorectification processing and checking 1 

3 Line work cleaning and editing – topological build -  6-7 

4 Adding LRI/LUC attributes - More complex because more hooks 
and also 213 small polygons with attributes in a table on map 
that have to be transferred into a table and then joined to the 
dataset. 

10 

 Total 20 

4.2.4 Cost Benefit Analysis  

This section provides a preliminary estimate of the costs of data capture and attempts to relate 

this to the perceived value of the data. There are conservatively 200 farm plans with an 

average area of about 450 hectares indicating c. 90 000 hectares of the GDC area is mapped 

to farm-scale as farm plans (additional areas have been covered by catchment-scale surveys). 

Value of data  

A first approximation of the value of these farm plans can be obtained by estimating the cost 

of original data capture. This valuation is based on the assumption that the data has the same 

value as the owner (GDC and/or its predecessor the East Cape Catchment Board) was willing 

to spend on capturing the data.  For simplicity, rather than try to calculate in 1980s salary 

figures and adjust for inflation, these figures are based on current salary costs, which would 

also equate to the approximate cost of replacing the data should the archive be deemed 

irretrievable (= full replacement cost). GDC staff (Freeman pers. comm.) estimated that field 

survey and map drafting to produce a farm plan from scratch would involve approximately 4 

days effort plus expenses. This gives a first approximation of value of the data set as: 

200 farms @ 32 hours (4 days) per farm = 6400 hours plus mileage/expenses 

Assuming that a Full Time Equivalent (FTE) relates to approximately 1350 chargeable hours 

per annum, once leave entitlements, administrative, training and other non-productive time 

has been allowed for, the effort involved in mapping 200 farm plans is: 

6400 total hours / 1350 FTE hours = 4.74 FTEs  

Based on a ball-park figure of $60,000 salary costs per FTE (Freeman pers. comm.) with an 

overhead factor of 2 this would equate to:  

(4.75 FTEs * $60,000) * 2 = $570,000 (including overheads). 

In addition to using the cost of data capture as an approximation of value, GDC (Freeman 

pers. comm.) also gave a preliminary estimate of the value to their organization of having 

ready access to the farm and catchment scale LUC data archive in GIS format as:  
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Saving staff time in accessing (0.5 FTE):  $30k per annum.  

Making better decisions, especially the regulatory space:  $25k per annum. 

The data have already had a useful life of 30+ years, and properly managed, might continue 

to be useful for quite some time. In this respect, it is interesting to note that 10 years at 

$55,000 per annum is roughly equal to the full replacement cost estimated above. Even if 

these data is superseded by newer mapping at some point in the future, it is highly likely that 

they would be used as a starting point for future mapping.  

Cost of Orthorectification 

The cost of orthorectification of the photomaps following the process discussed in this report 

can be estimated as follows:  

200 farms @ 4 hours per farm plan = 800 hours 

Looking at the total area of farm plans, we can estimate the cost per hectare for 

orthorectification of all 200 farm plans to be: 

90 000 ha / 800 hours = 112.5 ha/hour 

Using the Belmont Station farm plan as a more detailed comparison of effort per unit area we 

find the following: 

312 ha / 4 hours = 78 ha/hour  

This would indicate an alternative estimate for the cost per hectare for orthorectification of all 

200 farm plans to be:  

90 000 ha @ 78 ha/hour = 1150 hours 

The relationship between area of farm and time to orthorectify is undoubtedly not linear; 

however, these two estimates might indicate that the job of orthorectifying all 200 farm plans 

should take 1000 ± 200 hours effort.  

This can be converted into estimated dollar costs as follows: 

 Hours Charge-out rates Cost 

LCR  

800 

$200 

$160,000 

1000 $200,000 

1200 $240,000 

GDC  

800 

$90 

$72,000 

1000 $90,000 

1200 $108,000 
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Based on the figures above of $55,000 per annum, and assuming the skills are available at 

GDC, the cost of orthorectifying the farm plans can be recovered within 1.3–2 years. 

Even at LCR/CRI professional rates and taking the high end estimate of 1200 hours, the cost 

of orthorectifying the farm plans can be recovered within 4.5 years. 

So far life of data has been 30+ years – potentially expect 10–20 years more life out of 

survey.  

Because catchment scale maps proved more difficult to orthorectify, no cost benefit analysis 

has been attempted for these maps. 

5 Conclusions 

 The degree to which paired GCP identification can be successfully carried out is the 

critical success factor in achieving an acceptable outcome. 

 Using projective transformation with an underlying DEM to orthorectify photo maps of 

LRI/LUC farm plans is an effective approach for single images at larger scale (1:10 000 

scale or better).  

 This same approach is markedly less successful for mosaics at 1:15 000 scale or smaller 

scales, as image quality confounds efforts to achieve an acceptable standard of 

orthorectification from the original scanned map. 

 Recompilation of a new map based on contemporary (2012) orthophotographs and/or 

refinement of orthorectified boundaries according to the same contemporary 

orthophotographs were not attempted. While this seems an attractive possibility, the 

difficulty of correcting boundaries that incorporate hard-to-observe factors like 

lithology without field checking render an office-only approach questionable.  

 The Belmont Station farm plan has been orthorectified to an acceptable standard, 

showing how well we can transform the existing data onto modern GIS system. There 

is an implied conclusion that data that fits well is good quality data, but this analysis 

does not determine that the original data was good or bad quality. 

 A first approximation of cost-benefit analysis of the perceived value of the LUC data 

value versus the cost of data recovery suggests that data recovery into GIS is a 

worthwhile proposition with costs being recovered within 1.4–4.5 years. 
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6 Recommendations 

Recommendations are provided as three main options  

 scanning 

 scanning and orthorectifying 

 scanning, orthorectifying and digitizing. 

Additionally, prioritizing which maps are processed provides for a wide range of options for 

recovery of the most useful information to the required level of utility.  

6.1 Scanning 

All photomaps (single farm and catchment mosaic) should be scanned to an acceptable 

quality for digital archiving. At an estimated cost of $15–$20 per sheet, the total cost of 

scanning the full archive of physical maps should not exceed $10,000. 

 Recommended scanning specifications should follow those endorsed by National 

Library of New Zealand for Preservation Masters: 

File format:    TIFF version 6 

Bit depth:    8-bit per pixel (24-bit RGB) 

Colour space ICC profile:  none 

Capture resolution:   600ppi  

 At least one set of Preservation Masters should be stored offline on physical media in a 

secure and protected archival environment. This archive should be copied onto new 

media periodically (approximately once every 5 years) to ensure the data remains 

readable. 

 A set of Modified Masters (cropped and rotated if required, but not orthorectified) 

should be stored online as an archival dataset for easy reference by soil conservation 

and planning staff. 

6.2 Scanning and orthorectifying 

As for 6.1 plus, Gisborne District Council cost options for recovery of farm plans on single 

unorthorectified photo maps into orthorectified raster GIS format using the projective 

transformation approach outlined in this report. 

 All scanned unorthorectified farm plan imagery (or a prioritized subset) should be 

processed into orthorectified raster GIS format following the technical procedures 

outlined in this report. 

 A set of raster GIS format farm plan data sets should be stored online for easy use and 

reference by soil conservation and planning staff as background to contemporary GIS 

datasets. 

 At least one set of raster GIS format farm plans should be stored offline on physical 

media in secure and protected archival environment. This archive should be updated to 
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be compatible with current software versions and copied onto new media periodically 

(approximately once every 5 years) to ensure the data remains readable. 

6.3 Scanning and orthorectifying and digitizing 

As for 6.2 plus, Gisborne District Council cost options for recovery of farm plans on single 

unorthorectified photo maps into vector GIS format using the approach outlined in this report 

indicate that this is potentially cost-effective. 

 All orthorectified farm plan imagery (or a prioritized subset) should be processed into 

vector GIS format following the technical procedures outlined in this report. 

 A set of vector GIS format farm plan data sets should be stored online for easy use and 

reference by soil conservation and planning staff in contemporary GIS analyses. 

 At least one set of vector GIS format farm plans should be stored offline on physical 

media in secure and protected archival environment. This archive should be updated to 

be compatible with current software versions and copied onto new media periodically 

(approximately once every 5 years) to ensure the data remains readable. 

6.4 General 

 Gisborne District Council should cost options for recovery of Catchment Plans at 

1:15 000 or smaller scales on mosaicked unorthorectified photo maps into 

orthorectified imagery or full GIS format using the projective transformation approach 

outlined in this report indicate that this exercise is unlikely to yield satisfactory results.  

 We recommend that scanned catchment plans should only be orthorectified in high 

priority cases or where the quality of the photomaps indicates an acceptable result is 

possible. 

 The results of this project should be presented to Gisborne District Council.   

 Note: Gisborne District Council have already requested and funded travel and 

time for a half-day presentation on 31
st
 March, 2015 attended by 6 GDC staff.  

The results of the project were well received.  
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Appendix 1 Projective Transformation/Orthorectification Processing using 
ERDAS IMAGINE 2015 and ArcGIS 10.2. 

These are step-by-step instructions and notes for removing terrain distortion from farm and 

catchment plans stored on hard copy aerial photo bases, using ERDAS IMAGINE 2015 and 

ArcGIS 10.2 for post-processing 

1. Acquire a scan of the original non-orthorectified map – this needs to be a map with 

aerial photographic background, because in the absence of camera/sensor models we 

are going to attempt an orthorectification by matching ground control points that are 

identifiable both in the original imagery and in contemporary orthorectified imagery. If 

this is a hard copy you’ll need to scan it to a good standard – minimum 300dpi and use 

colour even if it is supposed to be a panchromatic image – the subtle differences of 

aged paper and ink may help differentiate line work later on in the processing. NOTE: 

for the Gisborne District Council examples – where provided with an inventory map 

use this rather than the LUC map since it has some dashed boundaries that will become 

important later on for same LUC/different inventory polygon boundaries. 

This may be even more of a problem where the inventory map does not have a 

photographic background. Is it possible to assign GCPs in the plan view image (no 

background photo) with the two raw images aligned in Cartesian space so the original 

orthophotograph is visible in the background?  

Steps here involve assuming that the two images can be aligned using simple 

georeference tool in ArcGIS. Given that they have been drawn by draughtsmen 

independently, they will never match perfectly – but five points and a couple of minutes 

get both roughly aligned. Then set page size to A0 and create a TIFF image at 400dpi to 

use as the input to the remainder of the process. It is best to convert TIFF to IMG 

format, as it works better in IMAGINE. 

2. Acquire orthorectified contemporary aerial imagery (the best free source is 

http://data.linz.govt.nz – but there may be other options direct from councils or using 

KiwImage). IMG, TIFF or JPEG2000 imagery are probably preferred formats.    

3. Start ERDAS IMAGINE 2015 – note there are changes to the user interface in the 

2015 version so these instructions are specific to that version. 

4. If you are using LINZ orthophotographs or similar that are tiled, it is best to stitch them 

back together in IMAGINE – use Mosaic > Mosaic Pro from 2D View. The aim is to 

put all the tiles you need in a single ECW (small/compressed) or IMG 

(large/uncompressed) file.  

If you have unprojected tiles you can either set the projection in IMAGINE before 

doing the MOSAIC (e.g.  JPEG downloads from LDS will have projection information 

that ArcGIS can read but IMAGINE ignores), or you can set the projection in the 

resulting mosaicked image. 

i) In the 2D View #1 right-click and open all of the projected image tiles. 
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ii) Under Manage Data > Edit Image Metadata use the batch command – set all input 

image tile projections to the correct option (e.g. NZTM) – it is tedious doing them 

one at a time if you have many to do. 

iii) Under Raster select Mosaic the 2D View and check that all of the images you 

want are represented in the wireframe (if there are any unprojected tiles they will 

be ignored if step 6 has not worked properly).  

5. In the 2D View #1 right-click to open the scanned TIFF image of the farm-scale map 

(recommend build pyramids for image if asked) and you will also need to open up a 

DEM for the area in question. This should be as high a resolution as you can manage – 

minimum will be LCR national 25m or 15m DEMs. 

6. Under the Multispectral tab select ‘Control Points’ and from the dropdown menu 

choose the ‘Projective Transform’ model from the list of model options in the ‘Set 

Geometric Model’ dialogue box and click OK. 

7. A ‘Multipoint Geometric Correction (MGC)’ window should open up that contains 

several tiles of images and a tabular section along the bottom for GCPs. Initially it will 

just have the scanned TIFF image. 

8. In front of the MGC window you should see a ‘GCP Tool Reference Setup’ dialogue – 

in this case take the first (default) option to collect reference points from an ‘Image 

Layer (New Viewer)’. 

9. In the ‘Reference Image Layer’ dialogue box – select the mosaic of contemporary 

orthophotographs that you have created in step 4 above; this is what you are using to 

identify GCPs, so it must be properly projected (you should see a ‘Reference Map 

Information’ dialogue box that confirms this – click OK) because you will be searching 

for features you can see in the scanned LUC map and on the orthophotographs.  

10. You should now see the ‘Projective Transform Model Properties’ dialogue box where 

you can identify your DEM that will be used to help remove terrain distortion – click 

on the file radio button, and then navigate to your DEM file (probably in TIFF format).  

You may see a message about not having ‘defined elevation information’. I have made 

my DEM and know it is correctly in NZTM, so I have ignored this warning – assuming 

the DEM has the correct units etc. (e.g. metres). 

11. If warned about vertical datum - click on the ‘Projection’ tab and make sure that NZTM 

is properly selected (or set vertical datum to GRS 1980, which is equivalent). 

12. Now you need to enter GCPs –select the cross-hairs tool and point at the target 

locations in both old LUC map and in the contemporary high resolution 

orthophotographs (as best you can match them). It is best to do this by pointing at 

locations in the original LUC map and then on the orthophotographs. The table at the 

bottom of the image should be populated with X input, Y input pairs in image/pixel 

coordinates from the LUC map, and in X ref, Y ref pairs of NZTM coordinates from 

the orthophotographs, and a Z ref elevation from the DEM. For an RPC order 2 model 

you need to capture c. 20–30 points from all around the original map image, preferably 

from a range of elevations as well. Avoid linear arrays of points, but it is probably a 

good idea to get points along rivers and/or ridges where identifiable targets are visible, 
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because these will be extremes of elevation and hence extremes of terrain distortion that 

you will want to have well accounted for. Note that higher orders of polynomial 

transformation can be used to correct more complicated types of distortion. However, 

to use a higher order of transformation, more GCPs are needed. For the best 

rectification results, you should always collect more than the minimum number of 

GCPs, and the GCPs should be well-distributed and as precise as possible. 

13. Once you have enough GCPs click on the ‘?’ button in the top menu bar of the MGC 

window to get the model to calculate a solution based on the points entered so far. After 

the model is solved, you should check your RMS Error before proceeding.  If the RMS 

Error is over 100, the result may not be useable.  

14. Save the model to a .gms file with a suitable name. 

15. Note that you will be asked if you want to store the GCPs in the images (you also get 

asked if you want to save them if you close the process without completing).  I 

recommend you try to save your GCPs to a separate file as well, so you can access 

them independently if you need to go back and add more points before re-running the 

transformation. 

16. Before leaving and closing the MGC window, click on the ruler icon at right end of 

menu icons to calibrate the image – a necessary step prior to carrying out geometric 

correction. This will close the MGC window and ask you if you want to save the 

model. 

17. Now carry out the geometric correction. Under ‘Multispectral’ tab select the big 

‘Transform and Ortho’ button and from the drop-down menu select ‘Ortho Using 

existing model’ and use the model saved in step 14. The model should ensure the DEM 

is correctly named. Select the resample method (probably best as ‘bilinear 

interpolation’), give the output image a suitable name to identify the model and/or the 

date it is created, check that pixels will be forced to be square, and round pixel size to 

suitable resolution (e.g. 0.5m or 0.45m). Once settings are complete, click the OK 

button. 

This marks the completion of the projective transformation process and you should now have 

a suitably named georeferenced and terrain-corrected image.  

18. Reduce the now orthorectified image to two colours (black and white), based on a 

threshold so that the line work and lettering are isolated from the greys of the remainder 

of the image. You can do this either by creating a signature file for the line work pixels 

and then using this in a supervised classification to isolate the line work, or you can run 

an unsupervised classification and let the data be automatically divided up by spectral 

signature. Using at least nine classes seems to guarantee that one or two of the classes 

will represent the line work and lettering. 

19. For supervised classification the process is as follows. 

i) Open the orthorectified farm plan and zoom in to see the line work fairly clearly.  

ii) Under the drawing menu – click on the ‘grow’ icon and select ‘grow’ from top of 

the drop-down menu. 
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iii) Click somewhere on the line work and IMAGINE will identify all of the 

connected pixels of the same or very similar value. You could do this multiple 

times to better define the area of interest (aoi).  Right-click and ‘save layer as’ to 

save the resulting aoi to your farm plan directory with a suitable name. This file 

will have the suffix .aoi, and will be the area on which the spectral signature of the 

line work is defined. 

iv) Under Raster > Supervised classification – select the ‘Signature Editor’. 

v) Now click on the third icon from left on the Signature Editor menu to create 

signatures from the .aoi file and save that file to a suitably named .sig file. 

vi) Under Raster > Supervised classification – start a classification using the 

orthorectified farm plan, a suitable output name, and the signature file you just 

created. I set the rules to parallelepiped and asked for anything not matching the 

signature to be unclassified. The aim here is to get an image that has only the 

black pen drawing from the original image – or as near as possible to that. 

20. Open this file in ArcGIS and run the model builder model to convert the raster image of 

the line work and LUC coding into vector format – and automatically remove some of 

the obvious non-line work material based on length, node ids and sinuosity of line 

work.  

21. You will need to manually clean up the line work so that it is topologically correct 

before you can build polygon topology. This particularly includes joining up any 

dashed line segments for inventory-only boundaries. 

22. Use the ArcToolBox Data Management Tools > Features > Feature to Polygon tool to 

create polygons out of the clean line work (only available with advanced licence). 

23. Manually assign attributes to polygons. The easiest approach is to add the necessary 

fields to the attribute table in the ArcGIS Geodatabase or Shapefile and then turn on the 

original transformed map image behind the polygon layer so that you can open the 

attribute table, select a polygon, and read and type the text codes into the table.  

 

 


